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Introduction   
  

One of the Handbook’s main objectives is to ensure that every member has a 

personal source of reference to the Club’s organisation.  It will also help 

members to see how they can, if they wish, help with the day to day running of 

the Club and help maintain its reputation of presenting a very friendly 

atmosphere to its visiting Judges and Presenters. The Committee welcomes 

suggestions for possible amendments/additions to the publication.   

     

 
Ludshott Photographic Club   

(Founded January 1995)   
   

PRESIDENT 
Kathleen Bird LRPS CPAGB 

   
VICE PRESIDENT   

 

Kathleen Bird LRPS CPAGB 2020 - 2021 

Phil Peddy ARPS APAGB 2008 – 2020   

Jim Henson 2008 – 2020 
   

CHAIRMAN   
Geoff Sargent 

     
PAST CHAIRMEN  

  

Harold Russell  2020 - 2022 

Kathleen Bird LRPS CPAGB 2019 – 2020 

Ken Lindup  2017 – 2019 

Brian Thomas 2015 – 2017 

Kathleen Bird LRPS CPAGB  2013 – 2015 

Mike Withers  2012 – 2013 

Kathleen Bird LRPS CPAGB 2010 - 2012 

David Huntingford  2008 – 2010 

Phil Peddy ARPS APAGB  1995 – 2008 
 



Members Handbook Aug 2022 P a g e  | 3 

  



Members Handbook Aug 2022 P a g e  | 4 

Contents  
 0 

Ludshott Photographic Club ........................................................................ 0 

Introduction ............................................................................................ 2 

Club Constitution ................................................................................... 9 

Organisation ...........................................................................................11 

CLUB SEASON ......................................................................................11 

CLUB MEMBERSHIP ...............................................................................11 

CLUB EVENINGS ...................................................................................12 

The Club Table .....................................................................................12 

Setting out the Hall ...............................................................................12 

Refreshments ......................................................................................13 

Print Competition Protocol ......................................................................13 

The “ROBBIE MORGAN” Tr ........................................................................13 

Robbie Morgan Trophy...........................................................................14 

Club Programme .....................................................................................15 

Internal Competitios ................................................................................16 

CLUB COMPETITION RULES ....................................................................16 

PROJECTED DIGITAL IMAGE (PDI) COMPETITIONS ....................................17 

Naming Your File ..................................................................................18 

Saving Your File ...................................................................................19 

Sending Your Image Via Email ................................................................20 

PRINT COMPETITIONS ...........................................................................20 

Naming Your File ..................................................................................20 

Print Mounting and Labelling ..................................................................20 

PRINT PRESENTATION ........................................................................21 

Print Mounting ...................................................................................21 



Members Handbook Aug 2022 P a g e  | 5 

Off the Shelf .....................................................................................21 

Face mounting ...................................................................................21 

Recessed mounting ............................................................................22 

Mounting board .................................................................................22 

Size .................................................................................................22 

Basic tools for print mounting ..............................................................22 

The Judge’s Viewpoint ..............................................................................24 

Digital Image Software ..........................................................................24 

General Image Composition ...................................................................24 

Presentation of your image ....................................................................25 

Landscape and Seascape Images ............................................................26 

Portraiture - Studio ...............................................................................26 

Nature Photography ..............................................................................27 

Record and Architectural Photography ......................................................27 

Still Life Photography ............................................................................28 

Sport/Action Photography ......................................................................28 

Panels of Images ..................................................................................28 

Promotion Procedure................................................................................30 

Support Services .....................................................................................32 

Club Visits ...........................................................................................32 

Publicity ..............................................................................................32 

Workshops ..........................................................................................32 

Venture Groups .......................................................................................34 

PREPARING IMAGES FOR VENTURE GROUP PAGES .....................................35 

AUDIO VISUAL GROUP ..........................................................................35 

Website .................................................................................................37 

Appendices ............................................................................................38 



Members Handbook Aug 2022 P a g e  | 6 

Appendix 1 – Suppliers of Photographic Materials, Printing & Camera Repairs .38 

General Advice .....................................................................................38 

Printing ...............................................................................................39 

Equipment (Cameras, lenses, printers, computers etc.) ..............................41 

Paper, Inks & miscellaneous materials .....................................................42 

Mount Board ........................................................................................42 

Ready Cut Mounts ................................................................................43 

Camera Repairs ....................................................................................43 

Computer Repairs, Upgrades & Servicing ..................................................43 

Appendix 2 – Competitions and Exhibitions ...............................................44 

Friendly Inter-Club Competitions .............................................................44 

SPA & PAGB Competitions ......................................................................44 

Appendix 3 – Club Insurance ..................................................................44 

 

  



Members Handbook Aug 2022 P a g e  | 7 

 

President      Kathleen Bird LRPS CPAGB 01428 714868 

 
COMMITTEE   

        

Chairman     Geoff Sargent 07714244556* 

Secretary     Steve Littler 01428717011 

Treasurer     Brian Marjoram LRPS 01428605258 

Int. Competitions Sec.   Paul Crook LRPS 01428713946 

Publicity Secretary John Price ARPS 01428482750 

Programme Secretary Colin Whitbourn 01420475560* 

TBA Sue Erler 01428746752 

 
SUPPORT SERVICES Non-Committee Appointments 
 
Webmaster Suzy Courtnage 07896236566 

Ext. Comps Sec. and 
Selection Co-ordinator 

Grant Dawkins 01420477763 

SPA Representative  Geoff Sargent 07714244556 

Social Events & Club Visits Vacant  

Membership Secretary Diana Grant LRPS 01428715483   
 

Volunteer members for each club evening 
 

Audio and video Stuart Frohmaier 

Teas and coffees 
Chairs and tables 

By Rota 

 
 
Please note the people shown above with a * work during the week, so 
please refrain from calling them during normal work hours 08.00 to 
18.00 Mon to Fri, instead use WhatsApp, email or IM to contact them and 
they will get back to you 
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SUB-COMMITTEES   
  
Promotions   

Chairman, Competition Secretaries and other Advanced Members invited by the 

Club Committee if required.    

(Purpose: To allocate new Members to an appropriate group; to review Members’ 

promotion prospects at the end of each season; and to promote or offer 

promotion where appropriate)   

   

Selection for Inter-Club Competitions   

External Competitions Secretary, External Competitions Assistant, and other 

Advanced Member by invitation.   

(Responsible for selecting images for all Inter-Club Competitions and any other   

Club designated event requiring images to represent the Club)   
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Club Constitution   

 

   
The Ludshott Photographic Club was founded in January 1995 and later that year 

a written constitution was produced:   

   

1. The Club shall be known as the “LUDSHOTT PHOTOGRAPHIC CLUB”   

2. The aim of the club is to provide a forum for members to develop skills, 

exchange information and understanding in the use of photography as a 

creative medium.   

3. Ludshott Photographic Club will present a programme of meetings, i.e., 

talks, competitions, workshops and activities to promote the aims. The 

Club programme shall run from September through to June the following 

year.   

4. An annual subscription shall be payable in September for one year of 

membership. The amount of subscription shall be determined by the 

Ludshott Photographic Club Committee and ratified at the Club’s Annual 

General Meeting.   

5. The subscriptions and any other fund raising will be used to cover the 

expenses of visiting speakers, venue costs, providing suitable equipment 

and any other costs incurred in the running of the Club to achieve the 

aims.   

6. The Club has an equal opportunities policy with membership open to all 

who are interested in any aspect of film or digitally based photography.   

7. The Annual General Meeting shall take place on the third Monday in June. 

The Committee will be elected at the Annual General Meeting for a period 

of one year, serving members may be re-elected.  The Chairman and Vice 

Chairman may not normally hold the same office for more than two years 

in succession.   Either may seek re-election having been out of office for 

at least one year.  The Vice Chairman may be elected Chairman.  The 

Treasurer will issue an audited financial statement at the AGM.   

 

8. The Club Committee will comprise elected members to include the 

following four Officers:  Chairman, Vice-Chairman, Secretary and 
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Treasurer plus such other co-opted members as may be required. There 

will be no paid officials of the Club.   

9. In addition to Club officials the Club will have honorary positions of   

President and Vice Presidents.  Nominations to be recommended by the 

Club Committee for election at the AGM.  Generally, nominees will have 

been long service contributors to the club.  The positions will be held for 

the duration of the President and Vice Presidents membership of the club.   

10. A member who incurs expenses in the running of the Club will be   

reimbursed.  The Treasurer will require a statement of expenses.   

11. Alteration of the constitution shall only be made at the Annual General 

Meeting, or at an Extraordinary General Meeting which may be called at 

the request of the Committee or a minimum of twenty-five of the 

membership.   

12. In the event of the winding up of the Club such funds that may exist, after 

all outstanding debts have been met shall be given to an agreed local 

charity.   

   

The above constitution was approved by members at the First General   

Meeting held on the 19th of June 1995 and amended (Clause 7) at the Annual   

General Meeting of 17thJune 1996.  Amended at Extraordinary General 

Meeting of 29th November 2004 and at the Annual General Meetings of 18th  

June 2007 and 15th June 2015.   

   
Brian Thomas  
Chairman   

  Ludshott Photographic Club    16.06.15   
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Organisation   
 

CLUB SEASON   
The main Club season runs from the beginning of September through to the end 

of the following June.   Other special activities may be arranged during July and 

August.   

   

CLUB MEMBERSHIP   
Ludshott Photographic Club is a member of the Surrey Photographic Association   

(SPA) and through this membership is affiliated to the Photographic Alliance of 

Great Britain (PAGB). 

 

Club Members may be: - 

 

Life Members who by invitation of the Committee are offered free Full 

Membership for life merited by long and valuable service.   

 

Full Members who, on payment of the annual subscription, are entitled to vote 

at General Meetings of the Club Members, to attend all regular presentations and 

meetings, to enter all club internal competitions, to enter SPA competitions 

where a condition of entry is membership of a subscribing photographic club and 

to attend workshops and guest speaker presentations at the discounted rate 

available to Full Members. 

Youth Members who, on payment of a reduced annual subscription, are entitled 

to all the rights and benefits of Full Members.  Youth Membership is available to 

all Members up to and including the Club year in which their twenty-fifth birthday 

occurs. 
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CLUB EVENINGS   
Safety Regulations   
   
We are required by the terms of hire of the premises and for our own peace of 

mind to have a record of those attending each meeting.   

   

In the event of an emergency a member of the committee will take the list out of 

the building in order that a safety check can be made.   

   

Members are asked to sign in by ‘ticking’ their name on the list that is kept by 

the ‘name badge’ box on the Club Table.   

   

The Club, at its inception in 1995, established a policy of members wearing 

name badges on Club evenings.   This has proved a very useful way of helping 

new members to get to know other members and helps visiting Judges and 

Lecturers.   Please return Badges to the box at the end of an evening.   

   

The Club Table 
   
This is usually situated at the back of the hall along with the Notices,   

Badge Box, Safety check list and up to date details of forthcoming Workshops or 

Visits.  Members are encouraged to take note of any information that may be on 

the table.    

 
Setting out the Hall  
  
Members of the Committee concerned with the evening’s programme have many 

things to attend to before the business of the evening commences, therefore it 

would be appreciated that members do not arrive until 7.30pm.   

   

The meeting co-ordinator will organise a set-up team of two to arrange the hall 

ready for the meeting. New teams are shown how to set the equipment up and 

where it is stored away.  The greater the number of teams the less your services 

are called upon.   
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Refreshments  
  
Members are asked to take their turn helping to serve the ‘Tea and Coffee’ in the 
break. A list of dates is on the Club Table with members' names against them. If 
you cannot make the date, it is your responsibility to find a substitute. If you have 
a problem with this, email info@ludshottpc.org.uk  Cups are available at the hall, 
but feel free to bring your mug for each meeting 

   

Print Competition Protocol  
  
Members are asked to observe the following generally accepted courtesies 

extended to visiting Judges and Presenters.   

   

• Keep back when a Judge is looking at prints on display prior to the start of 

a competition.   

• Prints on display should be handled only by a Club official or the 

Judge/Presenter.   

• Cotton gloves are worn by Club officials handling the mounts whenever 

possible.   

• Members are responsible for collecting their own prints from the display 

racks at the end of a competition.   

• Never approach prints to view them whilst holding any liquid refreshment.   

• During the interval allow time for the visitor to start their tea/coffee 

before you engage them in conversation – remember they have probably 

been talking for an hour or so and are gasping.    

 
 
 
 
 
 
 
 
   

 
The “ROBBIE MORGAN” Tr 
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Robbie Morgan Trophy 
 

This Trophy was presented to the Club by Mrs Edna Morgan in memory of 

Robbie.  Robert Morgan LRPS was a member of the Club from 1995 till his death 

in May 2000. Early in 2000 Robbie expressed a wish to present a trophy to the 

club to be used to encourage novices to photography.   

   

Robbie gave his wholehearted approval to a suggested format for the way the 

Trophy should be awarded annually. Robbie asked the Club to purchase a 

suitable trophy on his behalf but expressed a wish that, if possible, it should be 

more than just “another cup”.  Unfortunately, before the trophy arrived Robbie 

passed away. Edna asked that the Club still go ahead and fulfil Robbie’s wish and 

requested that the inscription should read:   

 

“Presented by Robert Morgan LRPS May 2000”   

   

The award is made on the recommendation of a Selection Committee comprising 

the Chairman, Vice-Chairman and Internal Competition Secretary of Ludshott 

Photographic Club. The award, to a member in the Entry Class, is for progress in 

a Club Season – September to June.   
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Club Programme   
  

The programme is organised by the Programme Secretary. The Programme 

Secretary reports to the Committee on progress and for their comments and 

suggestions.  Any member can, and is welcomed to, suggest guest speakers or 

new ideas to enhance the programme.   

   

Judges are booked using the SPA and PAGB Handbooks, in which are published a 

list of judges and speakers who are recommended to be of a suitable standard 

for clubs. Sometimes the net is cast wider into other Federations, (Southern, 

Sussex and the Chilterns)   

   

Speakers are found by personal recommendation from a member of the club, or 

from other clubs.  
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Internal Competitios   
  

The Club holds several internal competitions during each season: see printed 

programme and website. Entry to these competitions is restricted to members, 

and competitions are split between prints and projected digital images (PDIs). 

Each member may enter up to 3 images in each competition although, in the 

event of an excessive total number of entries, entries may be excluded 

under the limitation rule (see below).    

   

CLUB COMPETITION RULES    
1 All Sections are an Open Subject Competition unless otherwise stated on 

the programme. The Committee reserves the right to introduce variations 

on the competitions.   

2 All photographs contributing to the final image must be the work of the 

photographer.   

3 The Judge will be asked to mark images out of 10.  Half marks may be 

awarded.   

4 Certificates will be presented to all entries awarded 10 marks by the Judge. 

These images will automatically be eligible for the Best Image competition 

at the end of the season. (Must be the original image – copies are not 

acceptable).   

5 Images gaining 8.5 marks or less may be re-entered ONCE in the current 

or any future season as either a print or a PDI. At a competition a judge will 

often point out a flaw in an otherwise very good image, causing him to 

mark it down. This flaw may be easily fixed (by cropping, cloning etc.). Rule 

5 allows you to correct the image and re-enter it in another Club 

competition in the same medium or a different one (i.e., Print or PDI). 

Images that receive 9 marks or higher in a Club competition may not be re-

entered in another Club Competition.   

6 For Print competitions members should send in PDI images of their print 

and register the titles of their entries with the Internal Competition 

Secretary at least 3 days before the competition and in all cases to arrive 

no later than 6.00pm on the Friday preceding the competition. PDI images 



Members Handbook Aug 2022 P a g e  | 17 

should be emailed to the club address (competition@ludshottpc.org.uk). If 

email is not available images should be forwarded on a memory stick.  

7 Print competition entries should be brought to the hall and given to the 

Internal Competition Secretary by 7.45pm. Entries that have not been pre-

registered (see Rule 6) will not be eligible.   

8 PDIs should be sent to the Internal Competition Secretary via email at the 

club address (competition@ludshottpc.org.uk) or delivered on a memory 

stick at least 3 days prior to the competition, and in all cases to arrive no 

later than 6.00pm on the Friday preceding the competition.  Competition 

entrants should indicate their desired priority among the images 

submitted; this will indicate the image to be dropped (viz. 3rd 

image) if it becomes necessary to implement the limitation rule.   

9 All images brought to a Club meeting – for whatever reason MUST bear the 

member’s name and image title. This applies to digital images and prints. 

Carrying cases, bags, CD/DVDs and Memory sticks should also be 

labelled with the member’s name, particularly those being left with a 

committee member. 

10 Limitation Rule 

To give visiting Judges enough time to effectively judge and comment upon 

images, the Club will impose a limit of a maximum of 70 images in any one 

competition.  This rule will be implemented as follows: 

 Entrants indicate in their submitting email, their desired order of priority. 

 Entry to the competition is closed at the published deadline. 

 A random number is allocated to all Entrants. 

 Starting with the lowest number allocated, Entrants’ 3rd images are 

dropped until the allowable maximum numbers of images (70) is reached. 

 All dropped images may be entered into a future competition. 

   

 
PROJECTED DIGITAL IMAGE (PDI) COMPETITIONS   
   

Running two different competition types requires slightly different procedures on 

competition nights, and as the Club has grown these have been refined so that 

the evenings run smoothly and finish on time.    
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All images must be no larger than 1600 pixels wide x 1200 pixels high and 
must be in jpeg format. Entries should be sent to the Internal Competition 
Secretary, by 6:00pm on the Friday prior to the competition, by e-mail or on a 
memory stick.  All sticks must bear the member’s name for return. In each of the 
PDI competitions, members may enter up to three images (unless a different 
number is specified prior to the competition. Images must be in RGB mode (even 
for monochrome images), and in the sRGB colour space.   

   

Prepare your image as usual adjusting levels, sharpening etc. Before you resize 

it save it at full size so that you can use it again in the future to print or produce 

as a larger PDI. Only then should you resize it in Photoshop – Image > Image 

size or in Elements - Image > Resize > Image size.   

   
Use the TOP two boxes in the Resize window. These are under the heading of 

Pixel Dimensions. Ignore the Document Size (Width, Height and Resolution) as 

these refer to printed images.   

The Constrain Proportions and Resize Image boxes should both be ticked, and 
Bicubic should be selected in the drop-down box.    

   

If you are resizing a Landscape image, change the width to 1600. The height 

will look after itself and should be 1200 or less. If the height ends up greater 

than 1200 change it to 1200. This will reduce the width to less than 1600, but 

it will be sized correctly. If you are resizing a Portrait image, change the 

height to 1200. The width will look after itself.  The important thing is to 

ensure that no image exceeds 1600 pixels in width and 1200 pixels in 

height. 

Images that exceed these dimensions cannot be selected for external 

competitions. 

  

Naming Your File   
Save the image as JPEG and in sRGB colour space.  Our competition software -   

DiCentra – will allocate sRGB if it finds otherwise but the projected colours may 

not appear as you intended!   

The file name should consist of the image title, a space, the word by, a space, 

the entrant’s name.  
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So, the image file will be named:   

Title by Your name   

E.g.: Nice Scene by Joe Bloggs  

Please do not use the word ‘by’ in your title; the software will reject this.  

E.g.: On a tree by a mill by Tom Tit would fail because the software would find 
the word “by” twice and get horribly confused!  

  

Saving Your File   
Images are not accepted in Tiff format. If you do not get the option to save your 

file in JPEG format it may be because your image has more than one layer, (Layer  

> Flatten Image) or because it is not 8 bits. Go to Image > Mode and click 8 

Bits/Channel to correct this.    

   
   

  

You are recommended to save your file to your 

hard disk whatever its destination, so that you 

always have a copy. Keep your original file 

in case you need it again.   

   

Enter the file name as above   

   

Format - Select JPEG from the drop-down box   

   

Press Save to get the next screen.   

   

  

   

   

Choose quality 12 or Maximum for the Image   

Options   

   

Press OK   
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Sending Your Image Via Email   
Once you have saved your image it is ready to send to the Competition 

Secretary. If you are using Photoshop Elements (or similar software) do not be 

tempted to use the email facility within it. This resizes the file before sending, so 

it will arrive too small. Instead go to your normal email facility, create a new 

email to competition@ludshottpc.org.uk   

   

In the email, click on Insert > File. This should give you the standard Windows 

browser to locate your image. Double click on it, and it should be inserted into 

your email. Send the email as normal. Remember to tell us in your email your 

preferred order so that if the competition is over-subscribed, we know which 

image to drop.  If you don’t tell us, we must guess! 

 
PRINT COMPETITIONS   
A digital image of your print should be sent to the Internal Competition Secretary 

not later than 3 days prior to the competition by e-mail to 

competition@ludshottpc.org.uk, or on a memory stick, exactly as you would for 

a PDI competition.  All sticks must bear the member’s name for return.  PDIs are 

used at Print Competitions to assess the number of entries, to prepare score 

sheets and are also used by Selection Committees to assist in the selection of 

Club entries to Inter-Club and SPA competitions.  

   

Naming Your File   
As with PDI competitions it is important that when you submit your digital image 

of the print to the Competition Secretary it is formatted using the convention 

covered earlier (see above).   

  

 Print Mounting and Labelling   
   
All Print entries must be mounted on card - the mount size must be 50cm 

x 40cm; this is the standard for External competitions and if an undersized entry 

is selected for an external competition, the External Competition Secretary has to 

re-mount the image. Undersized mounts will therefore be disqualified. 

Mounts must be free of Velcro, sticky areas and any other material which might 

damage other entries. Please ensure that the backing sheet is securely 

attached as insecure Prints are liable to damage and create unnecessary 
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difficulties for the Print handlers who must work quickly in the dark! 

Prints must not exceed the permitted maximum mount size. There is no 

minimum print size.  

     

A LABEL should be positioned on the reverse of the mount, in the TOP centre 

of the mount, and about 25mm from the top edge. This position helps when 

handling the prints during a competition. The label should clearly state your 

name, and print title. (Suggested label size – around 70 x 50 mm – MINIMUM 

font size 16pt)   

   
A Club label with the Competition details for the relevant group will be affixed to 

the top left-hand corner of the reverse side of the mount, and the score given by 

the judge will be written on it.   

  
PRINT PRESENTATION   
Commercial Processing   
Commercially printed images are acceptable in competitions provided that the 

photographs they are printed from were taken by you.  

   

Print Mounting   
The mounting of a print into a suitable ‘matt’ is an important part of the 

presentation. There are several different techniques; some very simple, others 

requiring a degree of skill and patience.   

The most common forms of mounting are:    

   

Off the Shelf   

It is possible to buy a ready cut recessed mount from several different suppliers, 

art/frame and craft shops. It is normally an expensive way but very straight 

forward.  (See Appendix 1). 

   

Face mounting   
This is where the print is stuck onto the surface of a sheet of suitable mounting 

board using spray or plastic adhesives. This method is suitable for ‘flush’ 

mounting when the print material goes to the edge of the mount and is trimmed 

flush (together). It does however need skill. The disadvantage is that the print is 

rather exposed to surface damage during handling.   
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Recessed mounting   
This is where a hole is cut into a board and the print, supported by a second 

sheet of card, is secured to appear in the aperture. Recessed mounts can be 

produced by using the ‘Matt Cutter’ owned by the Club. A sheet of instructions 

and spare blades come with it. At present a small charge of 50p is made to help 

cover the cost of new blades.   

   

Mounting board   
Sheets of mounting board are readily available in a range of colours and sizes 

from local suppliers.   

   

Size   
Yes. Size does matter. As a Club we follow the recommended maximum sizes for 

exhibiting prints, this is set by the RPS, PAGB and the SPA. If a print is entered 

into an International, National or Federation competition or Exhibition and the 

mount including the print is above size, it will be rejected. Many Exhibitions have 

glazed frames and a standard is essential. A maximum size of 40cm x 50cm is 

the standard. The size and shape of the print within the mount area can be 

varied but may not exceed the maximum size.    

   
A general piece of advice is to give your print a fair amount of space on the 

mount.  Try to avoid narrow borders.   

   

Colour is a matter for the individual, but it should be in harmony and enhance 

the print rather than degrading or conflicting with it.  Black, white, grey, dark 

brown and cream are good and useful colours.   

   

Basic tools for print mounting   
   

• A good quality cutting knife and a supply of sharp blades.   

• A steel ruler, 60cm+ is a suitable size   

• A sharp pencil for marking out the cutting position on the back of the 

board.   

• A matt cutter, the club has one for your use.   

• Double sided tape   
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• Backing boards for protecting the back of the print when it is mounted.   

• A suitable adhesive tape for securing the print and backing board.   

• A suitable cutting surface. E.g., an offcut of mounting board or similar.   
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The Judge’s Viewpoint   
  

What are Judges looking for?   
Judges will try to interpret the image in the way, they hope, you intended.  

Remember they will probably never have seen the picture before.  If you can - 

use your title to provide a clue – but keep it short! In its lifetime the standard 

of digital photography has improved so much.  The related technology continues 

to produce upgrades.     

   

The following ‘pointers’ are not definitive but are drawn from the experience of 

judging and listening to other judges over several years.  They apply equally to 

Prints and Projected Digital Images   

   

Digital Image Software   
Judges will be looking for - how well the ‘software’ has been used in producing 

your final image - has ‘creative work’ been carried out to good purpose, or has it 

just ruined the original image – beware!   

   

If images have been brought into a picture – has it been done well, or can you see 
the ‘join’ – are shadows correct?   

   

Tip: – Avoid using a particular process/technique in a competition image until 

you have mastered the art in practice!   

   

General Image Composition   
• Does the photographer appear to have made full use of the camera’s 

viewfinder at the time of taking the image?   

• Have unwanted ‘Highlights’ been avoided particularly around the edges – 

these tend to draw the viewer’s eye away from the main subject matter.   

• Has the best viewpoint been selected to show the main subject to its best 

advantage?     

• Has the best use been made of the available light and its direction?   

   
• Is the image clear, clean and simple or are there areas that are rather 

’jumbled’ and difficult to make out?    
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• Has the main object of interest been placed in the strongest position? This 

is usually on the ‘third’ as diagrammatically illustrated below:   

      

                          Landscape Style  Portrait Style   

   

• If it is a colour image are the colours acceptable? Watch the greens – the 

human eye tends to reject a colour cast in green more than any other 

colour.   

• Does the image ‘read’ well?  Most people tend to view a picture, at first, 

from left to right as that is the way we read the printed word.  If you do 

decide to present a reversed image check, there are no name signs etc. 

That will give the game away.    

• Have ‘diagonals’ been used, when possible, to the best advantage?  Is the 

viewer’s eye kept within the image?   

   

Presentation of your image   
Presentation is very important; but please remember the mount should not 

conflict but enhance your image.  It is like the scenery in a stage production that 

is intended to provide a background for the cast and to help you to enjoy the 

production.   If every time a door opens the scenery shakes, it is not long before 

you are spending more time watching the door and not listening to the actors.  

So, with print mounts. If the colour holds your attention, you don’t pay full 

attention to the image.  Certain colours ‘bleed’ colour away from the image so 

appearing to ‘degrade’ the quality of the picture.   Try several neutral colours. A 

possible list is given elsewhere in the ‘Print presentation section’ of the   

Handbook. 

   
White Borders to images generally do not work – pulls the eye away from the 
image.  Wide white borders are a definite No-No.  If they are used, they should 
be very fine and toned down from a bright white.    
   
The following may help you with certain categories of image; but remember 

some considerations apply to more than one specialism.   
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Landscape and Seascape Images   
• Best choice of presentation format – It does not have to be presented in 

landscape style it can be in a square or portrait format.   

   

• Has consideration been given to: perspective, recession, depth of field, 

etc? Is the use of natural framing (trees, bushes, rock etc.) well balanced 

and not overpowering?    

   

• Is the horizon level particularly when water is part of the image’s horizon?   

   

• Is the viewer’s eye directed to the main feature and held within the 

picture?   

   

• Has the best use been made of available lighting, atmospheric conditions 

(mist, fog, haze) etc.? 

   

Portraiture - Studio   
• Does the model appear to be relaxed and in a comfortable position?     

   

• Is the composition of the picture showing the subject to the best 

advantage?     

   

• In most portraits one looks for sharp eyes and good flesh tones. Even in 

monochrome this can be seen in the tonal range.   

   

• Has the most effective lighting been used in relation to the style of the 

portrait?  This can be either natural, hi or low key.   

   
• Is this the most suitable background? Has the clothing and any jewellery 

worn by the model been recorded well without drawing the eye away from 

the main subject?   

• Avoid ’truncating’ limbs – elbows, hands etc.   
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Nature Photography   
• Is the subject sharp and all details well defined?     

   

• Has depth of field been used to best advantage?    

   

• In a moving subject - is the image sharp where it should be?  Has the 

camera been well ‘panned’ by the photographer?    

   
• Has the background been handled well?  It should not be intrusive or 

confusing. 

   
• Is the natural habitat shown adequately if it is included in the picture?   

   
• Has the composition of the image shown the subject to the best 

advantage?   

   
• Avoid cropping animal ‘portraits’ too tight. Leave room for the head to 

look in or out of the picture. 

   

NOTE: This subject includes all branches of Natural History ranging from 

geological studies to all forms of fauna and flora.  All images should be as seen 

by the photographer at the time of taking the image. No radical changes should 

be made to the image, but the removal of minor blemishes or distractions are 

permissible.  Titles should give the common name; the addition of the Latin 

name is optional.  The use of ‘twee’ titles is unacceptable if you are presenting 

your image in any type of nature competition/exhibition.  They can be used with 

a photograph presented as a pictorial image in an open competition.   

   

Record and Architectural Photography   
• This is a very specialized style of photography. Is all the detail pin sharp? 

* 

   

• Does the lighting show the shape and form of the subject?   

   
• Do the image colours appear as saturated as the original object would 

have been?    
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• Has the definition of unwanted/unavoidable surrounding information been 

kept to minimum?    

   

All these factors together with all the previously mentioned considerations combine 

to help produce a perfect ‘record’ image.  Final factor – does the viewer feel that 

the image conveys every little detail so well that there is no need to see the real 

thing?   

   

*Tip – ALWAYS use a TRIPOD to obtain maximum depth of field by using the 

lenses largest No. f stop e.g., f16, f22.   

   

Still Life Photography   
Judges will use similar criteria to that in Record photography particularly for the 

use of good depth of field to give a clean crisp reproduction of the subject 

matter. Evidence of the good use of lighting, all be it ‘natural or flash’ is also 

essential. 

   

Sport/Action Photography   
• Does the image capture the drama/movement of the moment expected 

with the subject matter at the time of taking?   

   

• Has the subject matter been viewed from the most advantageous 

viewpoint?   

   
• Does the image have a well-defined point of interest where needed?   

   

Note: The camera should capture the impression of speed and motion at the time 

of taking for the best results.  Effects added in ‘Photoshop’ or ‘Elements’ are very 

seldom so effective.   

   
Panels of Images   
To make a good presentation, more is required of the photographer than just 

selecting the requisite number of prints to make up the panel.  The following are 

some of the points Judges will be considering:   

• Photographic quality and composition of each image.   
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• Do the images go well together?     

• Have the prints been arranged so that they hold the interest of the 

viewer? (Some prints are best on the left, others on the right with many 

best suited for the centre).     

• If images are mounted, do the mounts enhance the viewer’s enjoyment?     

• If the mounts are mixed colours, have they been arranged to ‘balance’ the 

panel?     

• If there is a mixture of ‘landscape’ and ‘portrait’ style images, are they 

well-arranged within the panel?     

• The final panel should be ‘as one’ - nothing jarring the viewer’s eye.   

   

These considerations apply whether you are entering a panel of prints in a Club 

internal competition or submitting a panel for a photographic distinction in the 

Royal Photographic Society.   

   

N.B. More than one related image on a single 40 x 50 cm mount is considered to 

be a single print.   

   

In conclusion, members may wish to make their own list of points made by 

Judges that they have not previously considered. Judging is not an exact science 

and whilst many Judges will appear to use different criteria, they nearly all use 

the same underlying principles.  There are exceptions - but that’s life!  We all 

have images that have been highly praised by one Judge and heavily criticised 

by another.   

   
Tip:  Sleep on the Judges’ comments and look at them the following morning 

when you have quietened down – they may just have a point!   

 

Ensure there is nothing left in the picture for the Judge to criticise. 
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Promotion Procedure   
  

The Promotions Sub-Committee will initially assign new members to a group, 

(Entry, Intermediate or Advanced), according to the member’s photographic 

expertise and qualifications.   

   

At the end of each season the Promotions Sub-Committee will review members’ 

results from the competition year.  Based on the results a member may be 

promoted or invited to be promoted to the next group from the start of the next 

season.   

   

Members will normally be expected to have:   

• entered at least 75% of possible entries in internal competitions   

• gained an average mark of 8 or more   

• have received 3 or more high marks during the season   

• satisfied the Promotions panel that the required standard has been met 

and that promotion would benefit them while remaining fair to other 

club members.    

   

A member may also apply for promotion by submitting several images for 

assessment to the Promotion Sub-Committee, who, after careful consideration, 

will advise the applicant of their decision. Should the images not meet the 

standard required for promotion the applicant would be asked to attend a 

meeting with the Sub-Committee who will explain the reasons why promotion 

has been declined. A successful application will take effect from the next 

competition in the programme, but any entries that qualify for the Best Print/PDI 

competitions will only be taken from the member’s new group.   

   
The submitted images may consist of images that have previously been shown 

or new work, but not more than three years old.   

8 images for Entry to Intermediate      

10 images for Intermediate to Advanced    
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This procedure applies to both Prints (Prints must be mounted) and Projected 

Digital Images.    

   

A member can also ask to return to a previous group, Advanced to Intermediate, 

or Intermediate to Entry. The Sub-Committee will consider the member’s 

previous competition results and the effect the move may have on those in the 

lower group before the request is granted.    
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Support Services   
  

In addition to our regular meetings The Club provides several support services 

for members.  Various members of the Club help manage these facilities. See 

the Committee section for names of members responsible for these services.   

   

Club Visits   
Club visits are arranged to locations of photographic interest.   The timing of 

these, whether it be day or evening, is very much dependent upon the nature of 

the visit.   

Members who have visited a place that may be of interest to the Club are asked 
to advise the Social Secretary. Full details of dates and cost will be advertised.   

   

Publicity   
The Publicity Secretary sends regular reports and pictures of the Club’s 

activities, individual member’s achievements, and forthcoming programme 

events to the local media.   Additional reports are sent to the press of the 

Club’s activities outside the published programme. This includes exhibitions 

both on its own account and with other Clubs and organisations.     

   

The Publicity Secretary is always pleased to hear of relevant information from 

members.   

   

Workshops   
Workshops are organised during the season in addition to the normal Club 

meetings. They include practical and discussion sessions on many aspects of 

basic, advanced and digital photography. A nominal charge of £2 per member is 

made to cover the extra cost of hall rental.   

   

The Workshops are held either at our Club venue or members’ homes, usually in 

the evening.   

   

Full Day workshops are also held on specific topics when occasionally we have a 

guest speaker; there is normally an additional charge for these. 
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Venture Groups   
  

The object of the ‘Venture Groups’ is to provide small groups of members with a 

forum for the exchange of photographic knowledge and to encourage its 

members to take part in various forms of practical photography.   

   

Each group should agree a member to be responsible for arranging venues and 

meeting dates.   

   

The work of the group is controlled entirely by the members of that group.   

   

Ideally, Venture Groups should have up to eight members with a cross section of 

experience from entry to advanced workers.   This group size is suggested as 

members are expected, where possible, to meet in one another’s homes.    The 

suggested frequency of the meetings is around 4 to 5 times spread over the Club 

season. 

   

A few possible suggestions for projects that a group could undertake:   

   

1. Members visit an agreed place, either singly or in pairs over a period 

between meetings, to take photographs of their individual choice.   The images 

taken will provide a basis for discussion at the next meeting.  The venue can be 

selected at random by ‘dropping a coin’ on a map or a mutually agreed known 

place of interest.   

   

2. Two or three members take it in turn to make a short presentation of 

images they have taken on a personal visit. This often gives members fresh 

ideas on how to ‘record’ places visited or even holidays in exotic parts of the 

world.     

   

3. Groups set themselves the task of attempting a ‘specialist’ form of 

photography e.g., Close up of fungi, flower head, tree bark etc. Record work – 

each member photographs two or three objects at home – decorative plate, 

carving, piece of glassware etc.   At the next meeting members consider each 
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other’s success or failure in producing a true record.   Where possible maybe the 

actual article could be shown with the photograph.   This has a practical purpose   

– provides a record for insurance purposes in case of theft or possible breakage.    

   

Remember any images taken can be used in the Club’s internal competitions.   

   

The Club Programme Secretary periodically arranges an evening when Venture 

Groups will be able to present a selection of the work done by its members over 

the season.   

   

Each group has the chance to put their images and/or experiences onto the Club 

website, at any time during the season, allowing other groups to profit by their 

experiences.    

   

PREPARING IMAGES FOR VENTURE GROUP PAGES    
Photographs should be prepared and submitted in JPEG format according to the 

instructions provided in the earlier sections.   

   

The group should decide which images are to be put on the website. This can be 

a group decision, or the group might agree that each member will submit 2 or 3 

of their favourites.    

   

The images should be collated by the group co-ordinator, who should pass them 

to the Webmaster in one submission. If it is impracticable to deliver the images 

by email, Drop Box or other mass transfer method, one or more memory sticks 

may be used.   

Individuals may find it easiest to email them to their co-ordinator for collation. 

The group may decide to take it in turns to be the co-ordinator. Each image 

should be named in the usual way “Title by Author”.jpg   

   

AUDIO VISUAL GROUP   
This is a forum for club members who are interested in producing digital Audio 

Visual (AV) shows. The group meets about 5 times a year in one of the 

member’s houses, where the laptop and projector are set up. Members are 

invited to bring along any AVs they have made since the last meeting. The 
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second half of the evening is usually used to demonstrate techniques and to 

answer questions. Entry workshops are held from time to time.    

   

AVs produced by the group may be shown on Venture Group club evenings or at 

other meetings.   

   

To show AVs to anyone outside one’s immediate family the author must have 

copyright or a licence to use the soundtrack. If music is used from a CD or the 

internet, then a licence is necessary. The Club has a licence, and if the AV is 

produced for the club, it should say so. It is advisable for individuals to read the 

rules and decide whether to buy a personal licence. This can be done through   

The IAC at www.theiac.org.uk    
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Website   
  

The Club website’s address is www.ludshottpc.org.uk. Its aim is 

to:    

   

• Keep members informed of news and events, and to provide them with 

useful information.   

   

• Provide a shop window for potential new members or anyone else who 

might be interested in the Club.   

   

Club news, competitions and events are featured on the website. Photographs 

intended for the website should be prepared and submitted in JPEG format, 1600 

pixels x 1200 pixels, and should be named “Title by Author”.   

   

All images placed on the club website are of low resolution therefore making 

them disadvantageous to print. However, you should be aware that the club 

website is available to all in the world to view and possibly copy your images. 

Should you not wish your images to be placed on the club website, you should 

let the Webmaster know.   
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Appendices   
  

Appendix 1 – Suppliers of Photographic Materials, Printing & Camera Repairs   
   
The companies named in this section have been used by members for the supply 

of equipment and materials, printing and repairs / servicing. This information is 

offered to members as a guide and is NOT to be taken as definitive; neither does 

it imply any recommendation by the Club.    

   

General Advice   
For major purchases, including cameras, lenses, computers and printers, internet 

/ mail-order companies will usually offer the lowest prices.  However, it’s worth 

negotiating with both on-line and specialist “high street” retailers to ensure you 

get the best deals.  The internet is highly competitive, so it pays to shop around 

for the best deals – see the website of “camerapricebuster” under item 3.   

   

For the supply of materials and services, such as printing, mount board, paper and 

inks, etc., the internet / mail-order traders will also normally offer the lowest 

prices.    

   

Reputable on-line / mail-order traders can usually be relied upon to provide fast 

and reliable delivery.  It is not unusual to order materials, such as paper and inks, 

and have them delivered the following day.  Remarkably, some companies will 

print your images and deliver them within 1-2 days of the order being placed.   

   

High Street retailers have some advantages, notably the chance to handle 

equipment before you purchase.  You will be able to check out the features 

available on similar products with guidance from knowledgeable sales staff, always 

provided you use a reputable retailer which specialises in the product concerned. 

High Street retailers may also offer reasonable part exchange deals, discounts for 

members of the Club, or incentives such as free memory cards or filters.  It’s 

always worth asking!   
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Printing   
Many members print at home and the advice from a range of expert sources would 

indicate that the best, or at least most satisfying results, can be obtained from 

home printing. Always ensure your printer is correctly profiled and you are using 

the right paper and inks for the image you wish to create.   

   

Experimenting with different papers and inks can be rewarding.  Whilst some 

members prefer to use inks and paper from the same manufacturer as their 

printer, some have obtained good results using other papers and compatible inks. 

Inks that are compatible with own-brand inks from Canon, Epson, HP and Lexmark 

printers may retail at one third or less of the cost of the manufacturer’s branded 

ink.   

   

Home printing is not without its problems, which may be due to a poor set-up, a 

need for colour profiling, printer contamination, or it may simply be that your 

printer has inherent limitations.  Producing good quality black and white images 

at home seems to be particularly difficult, though some members achieve 

satisfactory results.    

   

The cost of home printing is also a factor. Recent research by a member indicates 

that on-line printing can offer cost savings when printer depreciation is included in 

the cost comparison.   

   

Several members routinely use professional printers, either because of difficulties 

experienced with the quality of home-produced prints, because they need a larger 

print than they can print at home, or for convenience. An added advantage is that 

if the quality of the professionally produced print is poor, suppliers will normally 

reprint at no additional cost.   

   

Observations on using professional printers:   
• Professionally produced prints are accepted for competitions, awards and 

distinctions by the Club and by the SPA, PAGB and RPS, etc., provided the 

final image is true to your original image.  You should check for more 

specific advice from these organisations.   
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• The cost of on-line printing varies tremendously.  For a print of the same 

size and identical paper, a good quality print from a low-end supplier will 

cost less than 10% of that from a printer whose charges are at the high 

end of the price spectrum.     

   
• When options of more costly papers are included the price ratio exceeds 

30:1   

   
• The advice of several experts is that the only sure way of making a 

comparison between different suppliers is by having the same image 

printed by the suppliers using the same paper.  Similarly, different papers 

can be compared by having the same image printed using a range of 

papers from the same or different printing companies.    

   
• High street printing is likely to be substantially more costly than on-line 

companies that are at the lower cost end of the price spectrum.   

   
• With a little practice most on-line printing sites are easy to use.   

   
• The delivery times and quality from on-line printers are normally very 

good, with the best of the budget printers providing prints that are of 

competition quality.   

   
• If your software permits, use the printer’s on-line “soft proofing” facility to 

check that your image will print as you want it.   

   
• Most on-line printers provide technical advice by e-mail, and some are 

happy to receive questions by telephone.   

      
Print Suppliers used by members:   
Most of the companies listed offer prints on a range of papers, prints on canvas, 

photo books, calendars, cards, etc., and will also produce prints from slides / prints 

and will digitize slides, etc. Some also offer mounting and framing services.   

   
DS Colour Labs Ltd https://dscolourlabs.co.uk/  (low-end of cost spectrum)   

Bonusprint  https://www.bonusprint.co.uk/ (low-end of cost spectrum)   

Photobox https://www.photobox.co.uk/  (low-end of cost spectrum)   
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BPD Photech http://www.photech.co.uk/    

   

Equipment (Cameras, lenses, printers, computers etc.)   
Amazon http://www.amazon.co.uk   

   

eBay http://www.ebay.co.uk    

   

Ebuyer http://www.ebuyer.com/ (for computers)   

   

London Camera Exchange http://www.lcegroup.co.uk/  (branches in Guildford, 

Southampton and Winchester). New equipment, plus second hand and part 

exchange)   

   

Park Cameras http://www.parkcameras.com/ (Burgess Hill, thus reasonably 

local)   

   

PC Specialist http://www.pcspecialist.co.uk    

   

Speed Graphic http://www.speedgraphic.co.uk/ (local with a very extensive 

stock of accessories)   

   
WEX Photographic http://www.wexphotovideo.com   

 

For  comparison of current prices try the website -

http://www.camerapricebuster.co.uk/   
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Paper, Inks & miscellaneous materials   
   
The following company’s stock some or all the following: photographic paper, ink 

(printer own-brand, own-brand compatible, bulk ink systems), batteries, memory 

cards, etc.   

Amazon http://www.amazon.co.uk   

Calumet Photographic http://www.calumetphoto.co.uk    

   

Choice Stationery Supplies http://www.choicestationery.co.uk/    

Discount Art http://www.discountart.co.uk   

eBay http://www.ebay.co.uk      

The Imaging Warehouse  https://www.theimagingwarehouse.com/  

Inkexpress http://www.inkexpress.co.uk/ (bulk ink systems)   

Just Ink and Paper http://www.justinkandpaper.com   

Photo Paper Direct http://www.photopaperdirect.com/    

Premier Ink http://www.premier-ink.co.uk/   

Pullingers http://www.pullingers.com/   

Also have a shop located at West St, Farnham.   

7dayshop http://www.7dayshop.com/    

Fotospeed https://fotospeed.com/  

Permajet https://www.permajet.com/ 

 

The lowest cost products are likely to be found by searching on-line, but if time is 

of the essence, stationery materials, backing board, sticky tape, etc., and some 

ink jet paper and ink cartridges are available from local suppliers such as - 

Blackwell Press, Liphook, Office Team in Guildford or Pullingers in Farnham. 

   
Mount Board   
   
Cotswold Mounts http://www.cotswoldmounts.co.uk/   

Discount Art http://www.discountart.co.uk      

Great Art http://www.greatart.co.uk/   
   

Just Glass (Woolmer Trading Estate, Bordon)   
 

Pullingers https://www.pullingers.com/   
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(Located at West St, Farnham and they offer a 10% discount to LPC members 

and on-line discounts for bulk purchase)   

   

Ready Cut Mounts   
These companies also offer a mounting and framing service: 
 
Cotswold Mounts http://www.cotswoldmounts.co.uk/   

Picture Lizard http://www.picturelizard.co.uk    

 

Camera Repairs   
 
Nikon UK https://www.nikonimgsupport.com/eu/BV_home?ctry=GB&lang=en_GB  

(Kingston-upon-Thames)    

 

Canon  https://www.canon.co.uk/support/consumer_products/repair/ 

 

Camera Repair Direct http://www.camerarepairdirect.co.uk/    

(Cranleigh)   

 

Computer Repairs, Upgrades & Servicing   
   
Trusted PC Man http://www.trustedpcman.co.uk    

The Tuck Box    
Headley Road    
Grayshott    
Surrey GU26 6LD    
Tel: 01428 606395    

   

PC Specialist http://www.pcspecialist.co.uk    

Units 20 + 20A   
Brockholes Business Park,   
Rock Mill Road,   

Brockholes,   
Holmfirth, HD9 7BN   

Tel: 0844 499 4000   
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Appendix 2 – Competitions and Exhibitions   
   
Please note these dates are only approximate as they are subject to change from 

season to season.   Some are biennial and alternate with each other.  Details of 

many will be published in the annual programme if known at the time of going to 

press.  They can also be found on the Club Website. The support of members at 

away matches is always much appreciated by the Programme and Competition 

Secretaries who make the fixtures on behalf of the Ludshott P.C.   

   

Friendly Inter-Club Competitions    
In addition to the published competitions in the programme there are often 

several occasions when the Club is invited to take part in competitions at other 

Clubs’ venues.   

   

SPA & PAGB Competitions   
Several individual and club competitions are held throughout the year. For up-to-

date information please visit the following websites:    

The calendar can also be accessed through the website here:  

http://www.thepagb.org.uk/ 

https://surreypa.org.uk/  

June (Biennial – odd, dated years) Exhibition in conjunction with Grayshott 

Gardeners – This is held in St Luke’s Church Rooms when Grayshott Gardeners 

open their gardens to the public.   

Appendix 3 – Club Insurance   
   

The following notes are only to be taken as a GUIDANCE and do not constitute a 

definitive statement on either Policy.   

   

PUBLIC LIABILITY INSURANCE   

This Policy covers the management of a Camera Club including Meetings, Social   

Events, Exhibitions and Outings, the details of which have been lodged with the 

Federation (Surrey Photographic Association). It covers (to the limit of indemnity 

- £ 5,000,000) Accidental injury to any person.   

Accidental loss or damage to Property.   

Nuisance, trespass to land or goods etc.   
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Legal liability for claimant’s costs and expenses.   

   

EXCLUSIONS; -   

Failure to take reasonable precautions.   

Asbestos – fear of Asbestos and removal costs exclusion.   

Legal liability arising from ABUSE.   Abuse shall mean as far as any young person 

under the age of 16: - Hurting mentally or physically.   

Forcing sexual activity.   

Contemptuous or insulting words or behaviour.   

   

This exclusion means that the Policy excludes any costs arising from a legal 

action brought against a club or any of its members etc. from an alleged act of 

abuse to any young person (under 16 years of age).   

   

ALL RISKS INSURANCE   

This Policy covers for loss, damage or destruction of Club Property either owned 

or in their custody or control.     This effectively means that Club property must 

always be in the custody and control of a Club member or officer.  EXCLUSIONS 

- there are many exclusions, but all are what should reasonably be expected and 

cover such as: -   

Theft from unattended vehicles unless out of sight in a locked boot or glove box, 

war, terrorism, revolution, riot, radioactivity, etc.   

   
If any member is in any doubt, then the Treasurer will be quite happy to make 

available all the documentation that he has in his possession.   


